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Introduction 
General 

Contact Center Modules (CCM) provides the user with the necessary tools 
to facilitate the management of call traffic. They are designed to provide a 
tightly integrated real time and historic reporting package and wallboard 
support for the eBusiness digital communications platform. The product 
consists of a set of fully integrated modules sharing a common database 
utilizing Interactive Directory and Database (IDD) technology. 
The suite of modules consists of the following applications: 

Call Center View (CCV):  
 Provides a management package for telephone based staff and 

supports any size Customer Facing Department (CFD) or contact 
center. To effectively control customer service levels, real time human 
resource management is essential and the Call Center View has been 
specially designed to manage the CFD’s or contact center’s most 
valuable and expensive asset – it's people. 

Call Center View Alarm Reporter:  
 Provides information (for each Call Center Profile) about alarms that 

have occurred within the contact center. The detailed alarm information 
for each directory number is presented in report format, which can then 
be printed. 

Wallboard Manager:  
 Real time information from the contact centre is essential to react to 

constantly changing telephone traffic levels and provide excellent 
customer service. Wallboards allow managers and staff to monitor the 
service being provided and respond immediately. Wallboards provide 
current information on the number of calls waiting, response times and 
service levels. Wallboard Manager provides the ability to drive 
Ferrograph and Spectrum physical wallboards and PC wallboards. 

PC Wallboard:  
 The PC Wallboard delivers traditional wall mounted wallboard 

functionality to the desktop but with the additional benefit of each PC 
Wallboard agent being able to configure and monitor a personalized 
view of the contact center. The PC Wallboard also enables agents to 
increase their productivity and maintain revenue levels with the added 
benefit of managing customer callback requests. 

Report Manager:  
 Provides in depth historical reporting on CFD or contact center activity. 

In addition to call information, the Report Manager also reports agent 
activity. This powerful package allows individual call records to be 
stored and reported upon months later.  

Workforce Management – Blue Pumpkin:  
 Workforce Management Interface allows integrated rostering, 

forecasting and scheduling systems to connect across the LAN to a 
comma separated variable (CSV) file containing a list of contact center 
related metrics. 
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Multimedia Module:  
 MultiMedia Module (MMM), is a customer contact software solutions 

that enables companies and departments to manage multimedia 
contacts into and out of the organization. MMM provides applications 
that manage Web Chat, E-mail and Web Call Back communications.  
For installation of MultiMedia Module, refer to the separate Installation 
Manual. 

Report Designer:  
 The Report Designer is a separate product that can be used in 

conjunction with Report Manager and is a software tool used for 
querying and reporting. It enables the user to create reports that 
contain data from their contact center database and schedule reports 
to be updated and printed.  It is installed when Report Client is installed 
but requires a licence to operate.  

INDeX Taskbar: 
 Enforces the user rights and password protection as well as providing 

a single point of access to the Contact Center Modules. 
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Call Center View Alarm Reporter 
Introduction 

The Call Center View Alarm Reporter has been designed to enhance the 
exception management used by Call Center View. The Alarm Reporter 
enables the contact centre supervisor to look back on the performance of 
the contact centre, on a daily or weekly basis, by reporting on certain 
criteria predefined by the contact centre supervisor. 
To view the alarm reports you must be logged onto the INDeX Tasbar with 
Administrator Access Level. As an Administrator, historic alarm reports for 
the profiles that you have created within the Call Center View are viewed 
one at a time. The historic alarm information is available to view for each 
individual profile. Profiles are analyzed one at a time. 
To obtain a historic alarm report file you must ensure that the relevant 
option is selected within the Alarm Setup options on the Call Center View 
application. These alarms are reported on a weekly basis for each 
individual profile. There is a separate file for each day of the week. The Call 
Center View will overwrite an existing file for the current day. 
There are two types of reports: 
• Breakdown Report displays detailed analysis of the alarm information 

for the selected directory number; 
• Summary Report displays a top-level overview of the historic alarm 

information for the selected directory number. 
Each report can be previewed prior to printing in either landscape or portrait 
orientation. The Report Preview is not dependent upon any printer drivers 
being installed on the PC. However, if a printer driver is not installed, the 
print facilities of the application will be disabled. 
The title of the report signifies the type of report, i.e. Breakdown or 
Summary. The report also displays the date and time that the data 
contained in the table was generated along with the User name and the 
Call Center View Profile Name. 
 

INDeX Taskbar 
INDeX Taskbar provides the ability to launch the INDeX CCM applications.  
The INDeX Taskbar also provides built in security through a logon 
procedure; i.e. you must log on to the INDeX Taskbar before lanching the 
INDeX CCM Applications. 
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Starting the CCV Alarm Reporter 
Before starting the Call Center View Alarm Reporter, you must ensure that 
you have logged on to the INDeX Taskbar with your User Name and 
Password. 

Note: You can only use this application with the access level of 
Administrator. 

 
To launch CCV Alarm Reporter: 
1. Click the Start button on the Windows taskbar. 
2. Point to Programs and then to INDeX CCM. 
4. Click CCV Alarm Reporter from the sub-menu. 
 

 
 

The screen is divided into three sections: 

1. Configuration pane: The view in this pane will vary, depending which 
tab is selected. Each tab allows you to select different options. 

2. Dn List pane: In this pane you can view the directory numbers for 
which historic alarm information can be reported. 

3. Report pane: Displays a report of historic alarm information for a 
selected directory number. 

 

Select Profile 
If there is no information showing in the DN list, make sure that a profile 
has been selected. See "File Menu" on page 12 for information on how to 
change the profile. 

Note: Alarms must have been set and triggered by the selected profile in 
CCV. 
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Administering CCV Alarm Reporter 
Configuration Pane 

The alarms are reported on a weekly basis for each individual profile. There 
is a separate file for each day of the week. An existing file for the current 
day will be overwritten by the Contact Center View, therefore allowing a 7-
day look-back in detail. 

Days Tab 
This is divided into seven days, Monday to Sunday. Click to select the 
required day(s). 
 

Device Types Tab 
Click to select the required Device Type(s). The available device types are: 

• Agent 
• Agent Group 
• Trunk 
• Trunk Group 
• Pilot Number  
 

Alarm States Tab 
Click to select the required state(s). The Alarm States are received from the 
CCV. 
 

Alarm Levels 
The alarm levels fall into two groups either Low or High. Each group has 
three types; Normal, Caution and Critical. 
The settings for the alarm levels are set within the Call Center View 
program. For more information about alarm levels please refer to the Call 
Center View user Manual. 
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Dn List Pane 
All the directory numbers for the selected configuration are displayed within 
this pane, as well as the Device Type, i.e. Agents, Trunks groups etc. 
There are four icons to symbolise each device type, as shown below. 

 - Agents  - Agent Groups 

- Trunks   - Trunk Groups 
 
The directory numbers can be viewed in four modes as shown below. The 
default setting is Details. Click the required view button to change the 
setting: 

 – Details   – Small Icons 

 – List   – Large Icons 
 

Sort Dn List 
The directory number information can be sorted in ascending or 
descending order. If the directory numbers are displayed in Details View 
mode, click the column title to change the sort to either ascending or 
descending order. 
You can also sort the information by: 

1. Choose Sort DN List from the Options Menu. You could also click the 

Sort button  from the toolbar. 
2. From the Sort Dn List screen select the required Sort By option. You 

can sort the Dn List by Dn, Name or Device Type. 
3. Select the Sort Direction, ie. Ascending or Descending and  click OK. 
 

Refresh Dn List 
To receive updated alarm information for selected directory numbers, you 
need to refresh the information. To do this: 

1. Select Refresh from the Reports Menu or click on the Refresh button 

. 
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Report Pane 
When a directory number is selected, a report of historic alarm information 
is displayed in the Report Pane. There is a short delay before the report is 
displayed, to enable you to select a different directory number. The report 
information depends upon the Report Type that you have selected, i.e. 
Breakdown or Summary. 
 

Select a Report 
Select the type of report you want by: 

1. Select Type from the Report menu or click the Report button . 
2. Click on either Breakdown or Summary to select the report type. 
 

Breakdown Report 
This report is the default report and will show when you first start the 
program. It provides detailed analysis of the alarm information for the 
selected directory number. 
The report shows the following information: 

• Alarm: Selected Alarm state(s).  
• Level: Alarm Levels.  
• Threshold: The alarm threshold specified within the CCV.  
• Start Time: Day and Time when the alarm occurred.  
• Clear Time: Day and Time when the alarm has been cleared within the 

Switch.  
• Acknowledged: Time and Day when the supervisor has 

acknowledged the alarm within the CCV.  
 

Summary Report 
This report displays an outline of the historic alarm information. The report 
shows the following information: 

• Alarm: Selected Alarm state(s).  
• Total: Total number of alarm occurrence for a specific alarm state.  
• Avg Duration: Average duration of a specific alarm state.  
• Max Duration: Maximum duration of a specific alarm state.  
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Sort Reports 
Either of the reports can be sorted in ascending or descending order. You 
can only sort the report that is showing in the report pane. To sort the report 
on screen: 
1. Click the required column title to be sorted. It will be sorted into either 

ascending or descending order,  
 or 
 Select Sort from the Report menu,  
 or 

 Click the Sort button  on the toolbar. 
2. From the Sort Report screen select what you want to sort by. The 

choices are depend upon whether you are creating a breakdown or 
summary report. 
Breakdown Report. - Alarm, Level or Start Time, Clear Time or 

Acknowledged.  
Summary Report - Alarm, Total, Avg Duration, or Max Duration.  

3. Select the Sort Direction, ie. Ascending or Descending and then click 
OK.  

Refresh Report 
To receive updated alarm information for selected directory numbers, you 
need to refresh the information. To do this: 

1. Select Refresh from the Reports Menu or click on the Refresh button 

.  
 

Preview/Print Report 
The Report Preview is enabled once an alarm information report is being 
displayed in the Report Pane. Each report type (Breakdown or Summary) 
can be previewed in either landscape or portrait orientation. The Report 
Preview is not dependent upon any printer drivers being installed on the 
PC. However, if a printer driver is not installed, the print facilities of the 
application will be disabled. 
The title of the report shows the type of report, eg. Breakdown or Summary. 
The report also displays the date and time that the data contained in the 
table was generated along with the User name and the CCV Profile Name. 

To preview a report, from, File menu select Report Preview or click  
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Toolbar Commands 
Toolbar Icons 

The Toolbar command buttons are also available from the menu bar: 

  Show/Hide Selection Pane: These buttons enable you to toggle 
between whether to display or not to display the Selection Pane. 

  Show Selection Pane. 

  Hide Selection Pane. 

 Profile: Enables you to select a different profile name. 
 

 Print Report: Enables you to print a report. 
 

 Report Preview: Enables you to preview a report prior to printing. 
 

 Report Type: Enables you to select either a Breakdown or a Summary 
Report. 

 

 Sort: Enables you to sort either the information displayed in the Dn List 
pane or the report pane. 

 

 Refresh: Enables you to obtain an up to date alarm information either 
within the Dn List pane or the Report Pane. 

 

    View buttons: These enable you to select the mode in 
which the directory numbers are displayed. The default view is Detail. 

  Detail View 

  List View 

  Small Icon View 

  Large Icon View 
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Menu Options 
File Menu 

The File menu incorporates the following options: 

• Report Preview: Enables you to preview the report prior to printing. 
This option is enabled only when a report is being displayed within the 
Report Pane. 

• Print Report: Enables you to print a report. 
• Selection Pane: Enables you to toggle between whether to display or 

not to display the Selection Pane. When the command has a check 
mark next to it, the Selection Pane is displayed. 

• Profile: Enables you to select a different CCV Profile Name. The 
Select Profile screen appears. This lists only the profiles that have 
been created by the currently logged on Administrator. If more than 
one profile is available, select the required one and then click OK. 

• Exit: Enables you to exit the CCV Alarm Reporter. 
 

Options Menu 
The Options menu incorporates the following options: 

• DN List View: Enables you to select the way the directory numbers are 
displayed. Select one of the following commands: Large Icons, Small 
Icons, List and Details. Experiment to find the view you prefer. 

• Sort Dn List: Enables you to sort the items by Dn, Name and Device 
Type. 

• Refresh Dn List: Updates the DN List alarm information. 
 

Setup Menu 
Setup menu incorporates the following options: 

Language: enables you to select the required language. The Alarm 
Reporter will automatically change to the selected language. 
 

Report Menu 
The Report menu incorporates the following options: 

• Type: From a sub-menu choose either breakdown or summary report. 
Breakdown: This is the default setting, displaying the alarm 
information for the selected directory number. The alarm details 
displayed are Alarm; Level; Threshold; Start Time; Clear Time and 
Acknowledged. 
Summary: This displays an outline of the historic alarm 
information. The alarm details displayed are Alarm States; Total 
number of the alarm; Average Duration for each alarm; Maximum 
Duration of each alarm. 

• Sort: Enables you to sort the report items by the appropriate column. 
This option is enabled when a report is being displayed for a selected 
directory number. 

• Refresh: Updates the alarm information for the selected directory 
number. This option is enabled when there is a report is being 
displayed for a selected directory number. 
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